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Introduction 
 
 

 You will gain the most from this guide by first reviewing it. Also, be sure to 
backup your data. 

 

The goal of the Wind2/Deltek FMSBillQuick Conversion Guide is to help new users effectively 
transfer data from Wind2 software (now Deltek FMS® by Deltek Systems Inc.) to BillQuick® (by BQE 
Software, Inc.). With BillQuick, you are equipped with the most powerful time entry and project 
management tools in the market. Full-featured, BillQuick Time and Billing helps you manage your 
company, whether your time, expense, billing and reporting needs are simple or you require complex 
billing, reporting and management capabilities.  
 
Conversion means a one-way transfer of data from one application to another. Once Wind2/Deltek FMS 
data is converted to BillQuick, you have a single database to work with. You can then archive the 
Wind2/Deltek FMS data at your convenience. The Wind2/Deltek to BillQuick Conversion Utility, which is 
built into BillQuick, transfers critical information from Wind2/Deltek FMS into BillQuick. This easy-to-use 
utility requires little or no manual effort! Compared to a manual conversion, you save days (even weeks) 
of non-billable time. You can start using BillQuick sooner! 
 

 Conversion time varies depending upon the size of your Wind2/Deltek 
FMS database. During testing, a 100-MB Wind2 database with over 200,000 
time entries required 1.5 hours for full data conversion into BillQuick. 

 
 

How to Use This Guide 
 
We encourage you to review How Data Conversion Works section. Written for users with a non-

technical background, it explains the Wind2/Deltek FMSBillQuick data conversion process. 
Understanding how data transfers will help you visualize what is happening behind the scenes. 
Wind2/Deltek FMS to BillQuick Conversion Utility walks you through the entire conversion process, step-
by-step. Finally, Data Flow explains the Wind2/Deltek FMS to BillQuick conversion in detail, including 
data field mapping across the two applications. 
 
 

Software Editions Supported 
 
All BillQuick editions – Basic (Microsoft Access database), Pro (Microsoft Access and SQL Express 
database) and BillQuick Enterprise (Microsoft Access, SQL Express and SQL Server database) – can 
convert data from Wind2 (version 2003.3.03 or later) or Deltek Financial Management System. 
 
If you have a Wind2/Deltek FMS SQL database, contact BillQuick Support or your Account Rep to have a 
BillQuick Consultant do the conversion for you.  
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How Conversion Works 
 
 

Understanding the basics of Wind2/Deltek FMSBillQuick Conversion is important whether you have a 
technical background or not. It helps you visualize what is happening behind the scenes as BillQuick 
transfers data from your Wind2/Deltek FMS application.  
 
The table below shows the flow of data from Wind2/Deltek FMS to BillQuick. You can be very specific in 
determining how and what data flows to BillQuick. 
 

Wind2/FMS 
Table Name 

Dataflow BillQuick 
Table Name 

Labor Codes 
 

 Activity Codes 

Expense Codes 
 

 Expense Codes 

Employee  Employee 

Client  Client 

Project  Project 

Time Record  Time Entry 

Expenses  Expense Log 

Invoice  Invoice 

Payment  Payment 

 

 To review detailed, field-by-field mapping of records between 
Wind2/Deltek FMS and BillQuick, see BillQuick Help, Wind2/Deltek FMS Data 
Conversion, Data Field Mapping. 

 
As you can see above, Wind2/Deltek FMS conversion with BillQuick is very comprehensive. The major 
benefit is that you do not have to re-enter Wind2/Deltek FMS data into BillQuick. BillQuick manages the 
process, using your conversion preferences. 
 
 

Conversion Rules 
 

To ensure accuracy and completeness of data transfer, Wind2/Deltek FMSBillQuick Conversion 
follows a set of rules. These are: 
 

1. Backup Data: Back up your Wind2/Deltek FMS databases. Store a copy in another folder 
or on a separate storage device. 

2. BillQuick Database: Create a new BillQuick database prior to transferring data from 
Wind2/Deltek FMS. Enter the required information such as Company Name, License and 
Registration keys, etc. in the Company screen. 
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Conversion Utility 

 
 
Existing Wind2/Deltek FMS users who are new to BillQuick only need to merge data once. From that 
point onwards, your time and billing information will be in a single data file (the BillQuick database). In 
other words, all your historical information – billed and unbilled time and expenses, paid and unpaid 
invoices, payment history – is now in BillQuick. After conversion, you can archive Wind2/Deltek FMS at 
your convenience.  
 
 

Wind2/Deltek FMS to BillQuick Conversion Utility 
 
The Wind2/Deltek FMS to BillQuick Conversion Utility populates your BillQuick Company database with 
data from Wind2/Deltek FMS. It automates and controls the conversion, stepping you through the 
process using a wizard to simplify the process. The wizard helps you to accomplish tasks that can be 
complex for the first time users and require experience.  
 
To convert data from Wind2/Deltek FMS to BillQuick, follow the steps mentioned below: 
 
1. BillQuick Company 
 
As a new BillQuick user, you must first create a new BillQuick company database (see BillQuick Help and 
other documentation for more details). 
 

1. In BillQuick, select File, New from the menu. Choose the type of database technology you wish 
to use. If unsure, choose Standard.  

 

 The database technology available to you depends on the BillQuick Edition 
purchased. If you are unsure what edition you licensed, select About BillQuick 
from the Help menu. The edition abbreviation displays right after the version 
number. 

 

Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Express 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Express 
Microsoft SQL Server 

 
2. On the New BillQuick Data File dialog, enter a name for your company database. Most 

commonly, the company name is used for easy identification. Click the Open button. BillQuick 
creates the database and opens the BillQuick Start-Up Interview wizard. 
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 The BillQuick Start-Up Interview can be closed and reopened later. To do 
so, select Wizards, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview panel, click the Next button.  
 
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity 

(service) and expense codes into your company database. These codes are not needed because 
items will transfer from Wind2/Deltek FMS into BillQuick. Click the Next button.  
 

5. Custom Labels allow you to change key business terms to suit your professional and company -
preferences in BillQuick. Customizing terms eases transition from your old time and billing 
solution. Select your preferred terms from the drop-down lists. When done, click the Next 
button. 

 

 
 
6. On the Company Name panel, enter your company name. Spell it exactly as it appears on your 

License and Registration or the Evaluation Key document or email.  
 
7. Click the Next button to accept the defaults on the remainder of the panels. You can update 

these options later in the Global Settings and User Preferences screen. On the last panel, click 
the Finish button. 

8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to 
create master information (employee, client, project, etc.). Skip this step as you shall transfer 
this data from Wind2/Deltek FMS. Click the Close button. 
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9. Next, the Company screen displays. Either complete the fields now and click the Save button 
when done, or click the Close button and perform this task later.  

 
10. From the File menu, 

select Login. For User 
ID, type ‘supervisor’ 
(without quotes), 
then for password, 
type ‘supervisor’ 
(without quotes). 
This gives you full 
security permissions 
in BillQuick to 
perform conversion 
tasks.  
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2. Backup Database 
 
Backup both your BillQuick and Wind2/Deltek FMS databases. Store a copy in another folder or on a 
separate storage device.  
 
To backup data in BillQuick, select Utilities, Backup Database from the menu. Follow the normal 
procedure to back-up your Wind2/Deltek FMS database. Close both applications before proceeding. This 
clears internal settings and allows you to start fresh. 
 
3.  Data Conversion 
 

1. Choose Wind2/FMS Conversion from the File menu. 
 

2. The ‘Wind2/Deltek FMS to BillQuick Conversion Utility’ displays. On the Welcome screen, click 
Next. 

 
3. On the BillQuick Database Type panel, select the database you want to use for data transfer. 

Select the first option, ‘Automatically detect…’ to have BillQuick scan the currently open data 
file. Click Next. 

  

 
 

 If you exit and return to Wind2/Deltek FMS to BillQuick Conversion Utility 
at a later time, BillQuick remembers the database. 

 
4. By default, the wizard accesses the currently open BillQuick Database. If you wish to select 

another file, click  to browse to its location. Click Next. 
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Similarly, select the Wind2/FMS Database Name to be used for data conversion. Select the Non-
SQL, SQL (Deltek) or SQL (Wind2) backend option. Wind2 main data file is typically named 
DATASET.DBC. Click Next. 

 

 
 

5. Identify where the Wind2/Deltek FMS Card File is. Wind2 Card File is typically named Sycont.DBF 

and located in your Wind2/Deltek FMS folder. Click  to browse to its location. Click Next. 
 

6. Before beginning the transfer, you can verify information by clicking Previous on each panel. 
When ready, click Finish to start the data conversion process.  
 

As Wind2/Deltek FMS data transfers data into your BillQuick company database, a progress bar displays. 
It stops automatically and informs you when it the process is complete.  



Data Flow 

Wind2/Deltek FMSBillQuick Conversion Guide 2013 v.2       Page 8 

Data Flow 

 
 
Data conversion from Wind2/Deltek FMS to BillQuick is completely automated with the Wind2/Deltek 
FMS to BillQuick Conversion Utility. However, if you wish more details on how Wind2/Deltek FMS data 
maps to BillQuick data, please review this section.   
 

 For additional information, see BillQuick Help, Wind2 FMS Data 
Conversion, Data Field Mapping. 

 
 

Data Field Mapping 
 
Data is stored in various tables in Wind2/Deltek FMS and BillQuick databases. Below is a list showing the 
flow of data from Wind2/ Deltek FMS tables (modules) to the corresponding BillQuick tables (modules). 

 

Wind2/FMS  
Table Name 

Dataflow BillQuick  
Table Name 

Labor Codes 
 

 Activity Codes 

Expense Codes 
 

 Expense Codes 

Employee  Employee 

Client  Client 

Project  Project 

Time Record  Time Entry 

Expenses  Expense Log 

Invoice  Invoice 

Payment  Payment 

 
The flow diagram shows a different view of the same movement of data.  
 
Master information in Wind2/ Deltek FMS flows into the master records in BillQuick. The same occurs 
for time and expenses, invoices and payments. BillQuick converts all pertinent data from Wind2/ Deltek 
FMS, providing familiar and consistent information and production results on the screen and in reports. 
While the look and feel is different, the underlying data is the same.  
 
Data fields in Wind2/ Deltek FMS map to corresponding fields in BillQuick. Below are the field mappings 
between Wind2/ Deltek FMS and BillQuick for each data table (module). The tables below include 
default values that transfer from Wind2/ Deltek FMS to BillQuick.  
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Wind2/FMS 
Employees 

Dataflow BillQuick  
Employee 

Employee ID  Employee ID 

Last Name + MI +  
First Name 

 Last Name + MI +  
First Name 

Hourly Billing Base 
Rate 

 Bill Rate 

Hourly Cost Rate  Cost Rate 

 

 You may notice an Employee ID ‘FromWind2’. BillQuick automatically 
creates this employee record for time and expense entries transferred from 
Wind2/ Deltek FMS if they are not against a specific employee. These entries 
are associated with this special Employee ID to ensure compliance with 
BillQuick data requirements.  

 
 

Wind2/FMS Client Dataflow BillQuick 
Client 

Client ID  Client ID 

Name  Company 

Address [associated card file]  Street 

Address [associated card file]  Street2 

City [associated card file]  City 

State/Province [associated card 
file] 

 State 

Country [associated card file]  Country 

Postal Code [associated card file]  Zip 

Fax [associated card file]  Fax 

Inactive (checkbox)  Status 

 
 

Wind2/FMS Labor 
Code 

Dataflow BillQuick 
Activity 

AR  Code 

Labor Code  Sub 

(if Time Off code,  
it is set to non-billable) 

 Billable: 
 

Set to 0  Bill Rate 

Set to 0  Cost Rate 
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Wind2/FMS Expense 
Code 

Dataflow BillQuick Expense 

Expense Code ID  Code 

Description  Description 

Billable Status:  
Billable/Ignore/Override 

 Cost 

Classification:  
Inactive/Closed, Open 

 Billable 

Multiplier*  MU% 

Inactive  Inactive 

*In Wind2/ Deltek FMS, there are two ways to markup the expense, using a multiplier and a markup. When 
the figure is transferred to BillQuick, the value of MU% is calculated using both values. 

 

 

Wind2 Projects Dataflow BillQuick Project 

Project ID  *Project ID 

Title  Name 

Client  Client 

Inactive/Completed (checkbox)  Status 

Hourly by default  Contract Type 

Set as 0  Contract Amount 

Set as 0  Service Amount 

Set as 0  Exp Amount 

Default date of data  
Creation in Wind2 

 Start Date 

Set as 0  % Complete 

Manager*  Manager 

State [associated card file 
attached] 

 State 

City [associated card file 
attached] 

 City 

Postal Code [associated card file 
attached] 

 Zip 

Country [associated card file 
attached] 

 Country 

*From Wind2/ Deltek FMS, where no specific manager is attached to the Project. 
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Wind2/FMS Time 
Records 

Dataflow BillQuick Time 
Entry 

Timekeeper  Employee ID 

Project  Project ID 

Lab Code  Activity 

Bill Hours  Hours 

Bill?  Billable 

B? (checked)  Approved 

Date  Date 

OT Hours*  OT (checkbox) 

Comment**  Description 

*In BillQuick, a separate time entry is made for overtime hours and the OT Flag is checked. 
**If the Comment field is not filled, BillQuick transfers the description of the activity labor code. 

 

Wind2/FMS 
Expenses 

Dataflow BillQuick Expense 
Log 

Employee ID (or 
FromWind2) 

 Employee ID 

Project  Project ID 

Transaction  Exp ID 

Unit Cost  Cost 

Bill? * (yes)  Billable 

Billing Status:  
Billable/Override,  

Do not Bill/No Charge 

 MU 

Charge  Amount 

Comment  Description 

Date  Date 

Bill Units  Units 

*In Wind2/ Deltek FMS, you can markup the cost using Unit Markup and/or Multiplier. When transferring data 
from Wind2/ Deltek FMS to BillQuick, it calculates the MU based on both the figures. 

 
 

Wind2/FMS 
Invoices 

Dataflow BillQuick 
Invoice 

Invoice Number  Inv # 

Invoice Date  Date 

Project  Project ID 

Invoice Amount  Amount 

 Invoice Balance  Balance 

Total Paid  Paid 

Client  Client ID 
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Wind2/FMS 
Payments 

Dataflow BillQuick 
Payment 

Client  Client ID 

Project  Date (payment) 

Invoice  Amount 
(Payment) 

Project Name  Memo 

Date Paid  Date 

Payment Type  Pay Method 

Amount  Amount 

Check #  Reference 

Notes  Memo 

Balance  Balance 

Project  Project ID 

Invoice  Invoice No 

Date Paid  Date 

Amount Paid  Paid 

Balance  Balance 

 
 

 
 
Congratulations! You have now an understanding of data flow from Wind2/Deltek FMS to BillQuick and 
how to ensure that the data transfer is accurate. To learn more, check the BillQuick Help. 

 
For more information, visit us at www.bqe.com.If you have any trouble in using the conversion utility, 
please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please call 
us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com. 

http://www.bqe.com/deltek/
mailto:Support@bqe.com
mailto:Sales@bqe.com
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